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	 Introduction

Copyright Terms and Conditions
Copyright CognitiveTPG LLC, 2012. All rights reserved. 
This edition of CognitiveTPG's ReceiptWare™ User Guide applies to Version 1.1.X, of ReceiptWare for Windows® and to future releases and 
modifications unless otherwise indicated in new editions. Readers may address comments concerning this publication to: CognitiveTPG, 
950 Danby Road, Ithaca, NY 14850. You may also send comments concerning this publication as an e-mail to the following address: 
tsupport@CognitiveTPG.com.

Welcome to ReceiptWare

Total Receipt Transformation
CognitiveTPG’s ReceiptWare changes the way you use and think about your receipts. Using a standard desktop PC, ReceiptWare gives you the 
power to take ordinary receipts and transform them into marketing and communications tools. With an easy-to-use interface, ReceiptWare 
can be used to create, edit, and save Receipt Formats (AXI files) for use in one lane or across your entire chain. Make lasting impressions with 
your customers using receipt features that reach far beyond your current POS application. 
Top logos, Margin Messages, Watermarks, and Bottom Logos all enhance corporate image, while features such as Surround Graphics, Text 
Attribute Switching, and Conditional Graphics allow you to present customized receipts targeted at specific customers. Individualizing 
each receipt is simple with ReceiptWare’s numerous triggers that allow you to call attention to special savings, rewards, and promotions 
in either monochrome or color. Using your imagination, you can create the look of receipts that you have always wanted. 

General Hardware Statement
Please be certain that the printer(s) you intend to use with this software are configured according to their manufacturer’s specification. 
We also recommend that you use printers with at least 2 MB of available flash memory. The larger memory will decrease your likelihood 
of experiencing problems storing and printing graphics files. 

Patents pending. © Copyright 2012 CognitiveTPG, LLC. All Rights Reserved. 
All trademarks or registered trademarks are the property of their respective owners.  Printed in U.S.A.  

Product specifications are subject to change in order for CognitiveTPG to continue to meet the needs of the market.
CognitiveTPG intends for ReceiptWare to be used only as expressly instructed. Any modification, alteration or use of ReceiptWare in a manner

not intended by CognitiveTPG is strictly prohibited (and may infringe on the intellectual property rights of others).
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	 CD Contents
Along with the ReceiptWare software, materials have been provided on the CD to familiarize users with the product features and 
functions. Contents include:

1.	 ReceiptWare User Guide.pdf 
2.	 Sample BMP Graphics

Cayuga Grocery.bmp
Cayuga Mmess.bmp
Cay Shoppers Club.bmp
Cayuga Coup.bmp

	 Cayuga Grocery Receipt.txt

3.	 Installer (ReceiptWare)
a.	 setup.exe

4.	 PCLoader.exe
5.	 HMUtility
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	 Installation
Insert the ReceiptWare CD into your CD-ROM drive to start the installation program. If it does not start automatically, do the 
following: 
a.	 Click Start>Run from the Windows® taskbar.
b.	 Click on the Browse button and find your CD drive.
c.	 Double click on the application called Setup or, select it and click on the Open button.
d.	 Click OK.

During installation, you’ll see the following windows:
Welcome – Welcome to the CognitiveTPG ReceiptWare setup program. Before continuing, it is strongly recommended that you exit all 
Windows® programs before running this setup program. Click on the Next button to continue.
Software License Agreement – Please review the software license before installing the software. To begin software installation, click 
on the Yes button to accept the terms, otherwise select the No button to exit.
Select Program Folder – The setup wizard will install the application in the default folder C:\Program Files\CognitiveTPG ReceiptWare. 
To install it in this folder, click Next. To install it in a different folder, click Browse, and select the destination folder that you want. You 
can choose not to install CognitiveTPG’s ReceiptWare by clicking on the Cancel to exit setup. Click on the Next button to continue.
Setup will add program icons to the Program Folders. You may type a new folder name, or select one from the existing folders list. Click 
on the Next button to continue. 
Setup Complete – Setup will indicate that it has finished installing CognitiveTPG’s ReceiptWare on your computer. From this window, 
you have the option to launch either the “Read Me Now File” or the CognitiveTPG ReceiptWare application. Click on the Finish button 
to complete the setup process. 
To launch the application, proceed to the directory where the application was saved in the setup process, and double click on the 
ReceiptWare icon. 
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	 Functionality

ReceiptWare Bitmap Conversion Tool

Converting BMP (Bitmap) Files to LGO (Logo) Files
It is important to note that ReceiptWare only supports LGO graphic files. Therefore, the first step in making your Receipt Format file 
is to convert all of the graphics that you wish to use from Bitmap (BMP) files to LGO files. This is done with a built in tool called the 
ReceiptWare Bitmap Conversion Tool. This tool can be accessed by selecting Tool>Bitmap Conversion Tool. You can also open this utility 
by clicking on the Bitmap Conversion Tool button located on the bottom right-hand side of the Legacy Graphics tab. 
1.	 Loading the bitmap – Click on the Load Bitmap button. From the open bitmap file 

window, choose a bitmap file and click Open. The bitmap you have selected is displayed 
on the screen. 

2.	 Resizing the bitmap – Resize the bitmap by clicking on the Resize button at the top of 
the screen. A window entitled Resize Bitmap will appear. Enter the desired width of the 
image in pixels in the Width field within this window. Allowed values are 10 to 576 pixels. 
The height of the bitmap will be scaled to maintain the aspect ratio of the image. After 
entering the desired width of the image in pixels, click on the Resize button. 

3.	 Modifying the colors – If you wish, you can adjust the Color option within the conversion 
tool to match the color that you will be using. (The Color option choices are limited to 
Red and Blue.) To do this, select the Color menu at the top of the screen and scroll down 
to select either red/black (red) or blue/black (blue), depending upon the paper on 
which you will be printing. Once you have selected the colors, click on the Modify 
Colors button to proceed. A window will appear asking for the maximum number of 
user colors as well as the conversion speed. For best results, it is recommended that 
you keep the maximum number of user colors to around 5 and the conversion speed 
to around 500. Once you have made your selections, click OK. Another window will 
pop-up entitled Manual Color Translation. The colors that appear on the left side 
of the window were detected by the software in the original bitmap file and broken 
down into percentages. The colors on the right side of window represent all of the 
gradients within the two-color scale that are available for re-mapping. Select each 
color in the left-hand column and match it with the desired color in the right-hand 
column. Then click on the Re-Map button to see the changes that you have made. 

Note:	 To complete the bitmap conversion process, Re-Map needs to be completed. Skipping this step will prompt an error. 

4.	 Saving options – After you have resized and modified the colors of the  bitmap that you would like to   use,    you  will need  to  save  your​  options.  
To do this, click on the Save Options button on the menu. At this time, you can either save your options as a logo definition (LGO) file or as a  
BMP file. 

Note:	 The bitmap conversion tool will only work with bitmap (BMP) files that are under 
24-bit. If you have a bitmap that is 24-bit or over, open the file with an application 
that accepts bitmap files (i.e., Microsoft® Paint, etc.), and then save it as a 12-bit 
bitmap file. 
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Other Features of the ReceiptWare Bitmap Conversion Tool
Aside from the ability to convert bitmaps to logo files, the bitmap conversion tool also 
allows you to create Margin Messages and text logos. Margin Messages are printed on the 
vertical right and/or left margins of the receipt and are generally made up of text strings, 
(i.e., website addresses). Text logos are useful in the absence of logos with graphical 
elements.

	When converting bitmap files to LGO files please make sure that 
the bitmaps are not saved as read only. To find out if they are read 
only files, right click on the bitmap file and choose properties from 
the menu. Uncheck the box next to the “Read Only” field within 
the Attributes area. We also recommend that all files be located on  
the C drive. 

1.	 Creating Margin Messages – To create a Margin Message, click on the Create Margin 
Message button located under the Tools column, which is located on the right-hand 
side of the screen. In the box labeled Enter a Margin Message string, enter the text 
(i.e., website address) that you wish to have for your Margin Message. After entering 
the text string, choose its font, font size, and font attributes (bold, italics) from the 
menu. You can also adjust the spacing above and below the Margin Message by 
changing the top and bottom values within the Extra Margin section. When all of 
your changes have been made, click on the Create Margin Message button located 
at the bottom of the screen. You will then be prompted to name the BMP file that you 
created and to choose a directory to which it will be saved. After clicking on the Save 
button, a window will appear asking if you wish to rotate the Margin Message by 
-90, +90 or 0 (NO ROT) degrees. Once you have made your selection, the BMP Margin 
Message will be loaded automatically into the ReceiptWare Bitmap Conversion Tool. 
Next, follow the directions in the previous section entitled Converting BMP (Bitmap) 
Files to LGO (Logo) Files.

2.	 Creating Text Logos – To create a Text Logo, click on the Create Text Logo button 
located under the Tools column on the right-hand side of the screen. In the box 
labeled Enter one line of the logo, enter the first line text (i.e., company name) 
that you wish to have incorporated. After entering the text string, choose its font, 
font size, and font attributes (bold, italics) from the menu. You can also choose the 
justification of the text line, be it left, center, or right. Once you have chosen how 
you wish the text line to appear, click on the Add Text to Logo button located in 
the middle part of the screen. Continue to add as many lines as you wish to have 
within your Text Logo. When completed click on the Done button located in the 
middle of the screen, and you will be prompted to save and name the Text Logo 
bitmap. Once saved, the Text Logo bitmap will be loaded into the ReceiptWare 
Bitmap Conversion Tool. Next, follow the directions in the previous section entitled 
Converting BMP (Bitmap) Files to LGO (Logo) Files.
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	 Legacy Functions
Many existing POS applications cannot support Top Logos, Watermarks, Margin Messages, or color graphics. With CognitiveTPG’s 
ReceiptWare software, you can configure your printer to print these graphics automatically without any change to the data stream from 
the point of sale application. These capabilities are referred to as Legacy Functions. Before we discuss these functions, it is important to 
define and explain the different types of Legacy Graphics. Legacy graphics include: 
1.	 Top Logo – A Top Logo is a user-defined graphic that prints at the top of the receipt 

before any other data. 
2.	 Margin Messages – Margin Messages are user-defined graphics that print periodically 

on the right and left margins of the receipt. 
3.	 Watermarks – Watermarks are user-defined graphics that print down the center of the 

receipt. They reside in the background of the receipt data in a shaded (dithered) mode 
so that it appears behind the text of the receipt. 

4.	 Bottom Logo – A Bottom Logo is a user-defined graphic that prints at the end of all of the 
receipt data. ReceiptWare allows you to specify up to 10 Bottom Logos

Using the Legacy Functions
As with every other ReceiptWare tool, we recommend having a sample receipt present with you when creating Receipt Formats.
1.	 Open the ReceiptWare software application.
2.	 Click on the Legacy Graphics tab.
3.	 If you wish for every receipt to contain a specific Top Logo, Bottom Logo, Watermark, and /or Margin Message, click on the radio 

button next to the Legacy Graphic that you wish to include.
4.	 Once you click on the radio button, a text box and button appear to let you specify a logo or LGO file. You can either enter the full 

pathname of the LGO file, or click on the Browse button to the right of the text box to specify it through Windows® Explorer. 
5.	 Once you have selected the LGO file, a smaller version of it appears on the screen that looks different than when it is actually 

printed. 
6.	 If you have a graphic that you want to include on your receipt but do not have it saved as a LGO file, then ReceiptWare’s Bitmap 

Conversion Tool can be used to translate the file. To open this tool, select the button called Bitmap Conversion Tool located on the 
bottom right-hand side of the screen. Or, click on Tools>Bitmap Conversion Tool to launch the tool. Please see the previous section 
called ReceiptWare Bitmap Conversion Tool for detailed instructions on how to use it.

7.	 If you include a Watermark on your receipt, you can change its shading to make it either lighter or darker. To do this, adjust the 
shading scale located at the bottom of the screen. Move the slider to the right of the scale to make the Watermark lighter or to the 
left to make it darker. 

8.	 If you wish to adjust the spacing, logo print speed and justification of any of the Legacy Graphics, click on the Advanced button 
located on the bottom right-hand side of your screen. Detailed instructions on using the advanced features are provided in the 
section below. 

Legacy Function Guidelines:
•	 Any Legacy Graphic you choose to include will be printed on every receipt that is 

generated. You may wish to print these graphics on every transaction receipt, but not on 
the Credit Authorization Slips that are sometimes subsequently printed. To suppress the 
legacy functionality on certain receipts, please refer to the Logo Suppression section of 
this guide.
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Legacy Functions Advanced Topics
The Advanced options allow you to fine tune the printing performance of the Legacy Graphics. Within this section, spacing, logo print 
speed, and justification can all be adjusted and saved. 
1.	 To use the Advanced options, click on the Advanced button located on the bottom 

right-hand side of the screen.
2.	 A dialog box will appear with tabs labeled Top Logo, Bottom Logo, Watermark, and 

Margin Message. To adjust the parameters of any of these Legacy Graphics, simply click 
on the tab for which the Legacy Graphic is named.

Note:	 All parameters are in dot rows, unless otherwise noted.  
(1 dot = 0.125 mm = 1/200”). 

Top Logo
1.	 Top Logo spacing – Occasionally, you may want to change the spacing above and 

below the Top Logo. To do this, there are two parameters to adjust: “Distance from top 
of receipt to start of top logo” and “Distance from bottom of top logo to start of print 
data.”
a.	 “Distance from top of receipt to start of top logo” – This option allows you to adjust the margins above the Top Logo. The default 

setting for this parameter is 50 dot rows or about a 0.25” (6.25 mm) margin. Increase this value if you want a larger margin 
above the Top Logo, or decrease it if you want to make the margin smaller. The range for this parameter is -99 to 154 dot rows. 

b.	 “Distance from bottom of top logo to start of print data” – This option allows you to 
adjust the margins below the Top Logo. The default setting for this parameter is 
48 dot rows or about a 0.25” (6.0 mm) margin. Increase this value if you want a 
larger margin below the Top Logo, or decrease it if you want to make the margin 
smaller. The range for this parameter is 1 to 255 dot rows.

c.	 To apply your changes, click on the Apply button located on the bottom 
right-hand side of the screen.

d.	 If you wish to restore either of these parameters to their original values, click on 
the Defaults button located in the middle of the screen.

2.	 Top Logo print speed – Generally, printing logos at the printer’s maximum 
speed results in clear and sharp images. However, complex multi-hued logos can 
sometimes degrade the level of print clarity. Adjusting or slowing print speed for a 
complex graphic will improve  
its crispness.
a.	 To change printing speed for the Top Logo, adjust the Logo Print Speed scale located at the bottom of the screen. Move the 

slider to the right of the scale to make the logo print faster or to the left to make it print slower. 
Note:	 Changing the printing speed value will only effect the related graphic and not the printing speed of the rest of  

the receipt.

b.	 To apply your changes, click on the Apply button located on the bottom right-hand side of the screen.
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Watermark
1.	 Watermark spacing – There are two ways that you can change the print spacing of the Watermarks on your receipt: “Distance from 

start of print data to watermark” and “Distance between consecutive watermarks in mm.”

a.	 “Distance from start of print data to watermark” – This parameter can be changed to adjust 
where the Watermark will be printed relative to the start of the print data. The default 
setting for this parameter is 50 dot rows or about 0.25” (6.0 mm) from the start of the 
print data. Increase this value if you want the Watermark to print further from the start of 
the print data, or decrease it if you want to make the distance shorter. The range for this 
parameter is 1 to 255 dot rows. 

b.	 “Distance between consecutive watermarks in mm” – This option allows you to alter the 
spacing between Watermarks. The default setting for this parameter is 25 dot rows 
or about 1.0” (25 mm) between printed Watermarks. Increase this value if you want 
to open the distance, or decrease the value if you want to close it. The range for this 
parameter is 1 to 255 dot rows.

c.	 To apply your changes, click on the Apply button located on the bottom right-hand side 
of the screen.

d.	 If you wish to restore either of these parameters to their original values, click on the Defaults button located in the middle of 
the screen. 

Margin Messages
1.	 Margin Message spacing – There are two ways that you can change the print spacing of the Margin Messages 

on your receipt: “Distance from start of print data to Margin Message” and “Distance between consecutive margin messages  
in mm.” 
a.	 “Distance from start of print data to Margin Message” – This parameter can be changed to adjust where the Margin Message will be 

printed relative to the start of the print data. The default setting for this parameter is 1 dot rows or about 0.0” (0.13 mm) from 
the start of the print data. Increase this value if you want the Margin Message to print further from the start of the print data, 
or decrease it if you want to make the distance shorter. The range for this parameter is 1 to 255 dot rows. 

b.	 “Distance between consecutive margin messages in mm” – This option allows you to alter the spacing between Margin Messages. 
The default setting for this parameter is 7 dot rows or about 0.04” (1.0 mm) between printed Margin Messages. Increase this 
value if you want to open the distance, or decrease the value if you want to close it. The range for this parameter is 1 to 255 
dot rows. Depending on the Toggle Mode, the separation may be between a Margin 
Message in the left margin and the next one in the right margin.

c.	 To apply your changes, click on the Apply button located on the bottom right-hand side 
of the screen.

d.	 If you wish to restore either of these parameters to their original values, simply click on 
the Defaults button located in the middle of the screen.



11

2.	 Margin message toggle mode – This option, which is located on the bottom left-hand side of the screen allows you to choose the 
margin(s) on which the Margin Messages will be printed. The alternating mode is the default parameter. There are four possible 
choices:

	 Both Sides – The Margin Messages print at the same time in both margins.
	 Alternating – The Margin Messages print in an alternating fashion between right and left margins.
	 Right Margin Only – The Margin Messages print only in the right margin.
	 Left Margin Only – The Margin Messages print only in the left margin.

a.	 To apply your changes, click on the Apply button located on the bottom right-hand side of the screen.
b.	 If you wish to restore either of these parameters to their original values, click on the Defaults button located in the middle of 

the screen.

Bottom Logo
A Bottom Logo is a user-defined graphic that prints at the end of all of the receipt data. ReceiptWare allows you to specify up to 10 
Bottom Logos
1.	 Bottom Logo spacing – Occasionally, you may want to change the spacing above and below the Bottom Logo(s). To do this, there 

are two parameters to adjust: “Distance from the bottom of the print data to start of bottom logo” 
and “Distance from end of bottom logo to end of receipt.”

a.	 “Distance from the bottom of the print data to start of bottom logo” – This option allows you 
to adjust the margins above the Bottom Logo. The default setting for this parameter 
is 48 dot rows or about a 0.25” (6.0 mm) margin. Increase this value if you want a 
larger margin above the Bottom Logo, or decrease it if you want to make the margin 
smaller. The range for this parameter is 1 to 255 dot rows.

b.	 “Distance from end of bottom logo to end of receipt” – This option allows you to adjust the 
margins below the Bottom Logo. The default setting for this parameter is 160 dot rows 
or about a 0.79” (20.0 mm) margin. Increase this value if you want a larger margin below 
the Bottom Logo, or decrease it if you want to make the margin smaller. The range for this 
parameter is 0 to 255 dot rows.

c.	 To apply your changes, click on the Apply button located on the bottom right-hand side of the screen.
d.	 If you wish to restore either of these parameters to their original values, simply click on the Defaults button located in the 

middle of the screen.
2.	 Bottom Logo print speed – Generally, printing logos at the printer’s maximum speed results in clear and sharp images. However, 

complex multi-hued logos can sometimes degrade the level of print clarity. Adjusting or slowing print speed for a complex graphic 
will improve its crispness.
a.	 To change printing speed for the Bottom Logo, adjust the Logo Print Speed scale located at the bottom of the screen. Move 

the slider to the right of the scale to make the logo print faster or to the left to make it print slower.
Note:	 Changing the printing speed value will only effect the related graphic and not the printing speed of the rest of  

the receipt.

b.	 To apply your changes, click on the Apply button located on the bottom right-hand side of the screen.
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	 Text Attribute Substitution
The Text Attribute Substitution feature lets you select attributes that your application currently uses and has your printer change or 
re-map them to a different set of attributes, most likely including color. For example, if your application uses underlined text to indicate 
a sale item, you can instruct the printer to print all underlined text as red and bold for an extra visual punch!

	 Before:	 Get $10.00 cash when you open a new account

	 After:	 Get $10.00 cash when you open a new account 

Using the Text Attribute Substitution Tool
As with every other ReceiptWare tool, we recommend having a sample receipt present with you when creating  
Receipt Formats.
1.	 Open the ReceiptWare software application.
2.	 Click on Text Attribute Switching tab.
3.	 Identify the text attributes (i.e., bold, italics, etc.) on your receipt that you wish to change.
4.	 Check the boxes next to these attributes in the first From section located at the top of the screen. You may choose a variety of text 

attribute combinations (i.e., choose underline and italics). A sample of your choice(s) is displayed on the right-hand side of the 
screen.

5.	 Select the text attributes that you would like the printer to use instead of the set that you have chosen in step 4. Check the boxes 
next to the chosen attributes in the first To section located at the top of the screen. Once selected, you will see a sample of your 
choice(s) displayed on the right-hand side of the screen. 

6.	 Repeat steps 3, 4, and 5 if you have a second set of text attributes that you want altered. 

Text Attribute Substitution Guidelines
•	 If Color Reverse is selected, and Color is not selected, the result is black text on a color 

background.
•	 If Color Reverse is selected, and Color is selected, the result is color text on a black 

background.
•	 Color Reverse and Reverse Video cannot both be selected. 
•	 If Reverse Video is selected, and Color is not selected, the result is white text on a black 

background.
•	 If Reverse Video is selected, and Color is selected, the result is white text on a color 

background. 
•	 Choosing the Double Wide attribute may cause some text to wrap, depending upon the 

position of the text that is to be re-mapped. 
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	 Financial Conditional Graphics
The Financial Conditional Graphics feature of ReceiptWare gives your printer the ability to print stored graphics when predefined text 
triggers are present in the receipt data. It supports up to 112 different Trigger Graphics as well as instruction sets (i.e., justification) on 
how to print each one. With this ability, your imagination is the only limit when creating a unique and customized receipt for every 
customer. 

Using the Financial Conditional Graphics Tool
As with every other ReceiptWare tool, we recommend having a sample receipt present with you when creating Receipt Formats. 
ReceiptWare text triggers are limited to a predefined of Trigger Strings. Trigger Strings are text strings that are present in the printed 
receipt data. The following trigger formats are available:

To print a Financial Conditional Graphic on your receipt, you have several types triggers to choose from. Before specifying the triggers, 
you need to make a decision about the trigger that best suits the message that you are delivering. For example, if you are printing 
a coupon that is printed when the customer Deposits $40.00 or more. You can create a trigger for $40.00 Total – the printer will 
automatically print the coupon when Deposit $40.00 or more is present in the receipt data. You can specify another trigger to print a 
different coupon if the customer Deposits less than $40.00.

To use Financial Conditional Graphics:
1.	 Open the ReceiptWare software application
2.	 Click on the Financial Conditional Graphics tab.
3.	 Identify the graphics that you want to print. You may want graphics for the holidays, one for 

a local sports team or school, or a special one to reward loyal customers. If you have these 
graphics but they are not in an LGO format, then ReceiptWare’s Bitmap Conversion Tool can be 
used to translate the files. To open the Bitmap Conversion Tool, proceed to the Tool drop-down 
menu, and choose Bitmap Conversion Tool. Please see the section called ReceiptWare Bitmap 
Conversion Tool for detailed instructions on how to use it.

4.	 The ReceiptWare utility supports Enable Text Trigger, Enable Deposit/Balance and Enable Time/
Date. Select a trigger number by scrolling through the Trigger index located on the top left side 
of your screen directly above Graphic File.

5.	 Specify the graphic that you want printed based upon the associated trigger. In the field 
labeled Graphic File, you can either type in the full pathname to the LGO file or click on … 
the button to the right of the text box to specify it through Windows® Explorer. Once you have 
selected the LGO file, a smaller version of it appears on the screen that looks different than 
when it is actually printed. 

Enable Text Trigger: 
The text strings are not able to be modified by user.
a. New accounts
b. Money Market
c. Savings
d. Checking
e. Credit Card Payment
f. Mortgage Payment
g. IRA
h. Annuities
Only compatible in applications where the listed 
word(s) is present on the printed receipt.

Enable Deposit/Balance: 
Based on the triggered amount being greater than or  
less than the “Amount.” Only compatible in  
applications where the words “Deposit,” or “Balance"  
is present on the printed receipt.

Enable Date/Time: 
Based on the triggered Date/Time. You can choose 
Time only, Every other day or you can specify a start 
and end date to print the promotion. 
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6.	 Once you have finished specifying your Financial Conditional Graphics, move to the 
next one, if you desire another. To scroll to the next set, use the > button. To go back to a 
previously defined set use the < button.

7.	 Repeat steps 4–6 to define all the Financial Conditional Graphics that you want to 
include.

Financial Conditional Graphics Guidelines 
•	 Make sure that you choose trigger strings that will not appear in other parts of the receipt 

or the printer may print the graphic at an undesired location.
•	 To disable Financial Conditional Graphics, click on the check box of any trigger. To disable 

other Financial Conditional Graphics, scroll to the next set and click on the check box, use 
the > button. To go back to a previously defined set use the < button.
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	 Conditional Surround Graphics
Many financial institutions use the receipt to convey to their customers the money that they saved or the loyalty points that they have 
earned. Given the limitations of the POS application, the messages that the financial institution intended to “call out” get lost within the 
receipt. The Conditional Surround Graphic feature of ReceiptWare gives you the ability to replace your current method of highlighting 
with surround graphic shapes and color. For example, if your current application uses asterisks to emphasize savings, you can instruct 
the printer to remove those asterisks, surround the savings with an ellipse, and print the surrounded text in color. 
Before:

*********************
** Total Deposit  $ 150.32 **

*********************
After:

Total Deposit $ 150.32

Using the Conditional Surround Graphics Tool
As with every other ReceiptWare tool, we recommend having a sample receipt present with you when creating Receipt Formats. When 
specifying “triggers,” we advocate avoiding the use of numbers as well as text that could appear elsewhere in your financial receipt. Try 
to choose a trigger that is unique and will be printed only on specific transactions. This will reduce the chance of printing a graphic, be 
it conditional or surround, in an undesired place on the receipt. 
1.	 Open the ReceiptWare software application.
2.	 Click on the Conditional Surround Graphics tab.
3.	 After clicking on the tab, a secondary window will appear on the right-hand side of your screen called Conditional Surround 

Graphic Sample. This window will serve as a guide by visually displaying the changes that you make to the parameters as they 
occur. 

4.	 Assign the trigger number by using the toggle buttons (< or >) located underneath Current Trigger, which is on the top left-hand 
side of your main screen. Use the default number, which is 16, or advance for multiple triggers. Use the > button to move to the 
next trigger or the < button to go back.

5.	 Identify your trigger string, and type it into the Trigger String box. As mentioned above, we advocate avoiding the use of numbers 
as well as text that could appear elsewhere in your receipt.

6.	 Choose the shape that you want to be represented as the Surround Graphic from the Surround Graphic Type box. Your choices 
include: rectangle, oval, ellipse, or freehand ellipse.

7.	 Choose the color of the Conditional Surround Graphic that is to be printed on the receipt. Your choices include color or black.
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8.	 Now that you have determined the Conditional Surround Graphic shape and color, you need to determine its size. 

Change all the parameters for the Conditional Surround Graphic row. Please note that as you alter the values in these 
boxes, the changes will be made dynamically in the Conditional Surround Graphic Sample window. The parameters are  
as follows:

a.	 Start char – This parameter, measured in character columns, specifies where the left edge of the Conditional Surround 
Graphic will print relative to the left edge of the receipt. The default value for this parameter is 0 character columns. To move 
the Conditional Surround Graphic to the right, increase the value within the Start char field.

b.	 Width in chars – This parameter, also measured in character columns, determines the width of the Conditional Surround 
Graphic. The default value for this parameter is 1. To increase the width of the graphic, increase the value within the Width in 
chars field. 

c.	 Height in chars – This parameter, measured in characters or lines, represents the vertical height of the Conditional Surround 
Graphic. The default value for this parameter is 3. To increase the height of the Conditional Surround Graphic, simply increase 
the value within the Height in chars field. 

9.	 After identifying the specifics of the Conditional Surround Graphic, identify where the data within your shape will be positioned 
on the receipt. To do this, you must change the parameters for the Data Surround Area row, which is located directly underneath 
the Conditional Surround Graphic row. Please note that as you alter the values within these boxes, the changes will be made 
dynamically in the Conditional Surround Graphic Sample window. The parameters are as follows:
a.	 Start char – This parameter, measured in character columns, represents the position of the first character of text to be 

surrounded in relation to the left edge of the receipt. The default value for this parameter is 0 character columns. To move the 
Data Surround Area to the right, simply increase the value within the Start char field.

b.	 Width in chars – This parameter, also measured in character columns, determines the width of the text that you wish to 
surround. The default value for this parameter is 15. To increase the amount of text to be surrounded, increase the value within 
the Width in chars field. For example, if you want to surround the words “YOU SAVED,” you would enter 9 as a value for Width 
in chars, because it contains 9 characters. 

c.	 Height in chars – This parameter, measured in characters or lines, represents the vertical height of the text to be surrounded. 
The default value for this parameter is 3. To increase the height of the Data Surround Area, simply increase the value within 
the Height in chars field. 
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text text

YOU Deposited

text text

3

4

10.	 Identify the Mode. Choosing a Mode will determine how the Conditional Surround Graphic shape is positioned with respect to the 
lines above and below the shape. Options include:
a.	 Mode 1: Pre-surround line, surround line(s) – Circles the data surround area line and the line immediately above  

that data. 
b.	 Mode 2: Pre-surround line, surr line(s), post-surr line – Circles the data surround area 

line, the line immediately above that data, and the line immediately below the 
data. 

c.	 Mode 3: Surround line(s), Post surround line – Circles the data surround area line and 
the line immediately below that data. 

d.	 Mode 4: Surround line(s) – Surrounds the data surround area line only and provides 
a blank line above and below that data, enabling you to add a space to your 
receipt above and below the data.

These are examples of modes 1–4:

	 Mode	 Before	 Replace	 Non-Replace	 Valid Trigger  
			   Mode	 Mode	 Types

 

Note:	 Mode selection will dictate which trigger types you can select.

	 text text
******** 

YOU Deposited 
text text

text text

YOU Deposited
text text

1, 4

	

1, 4

	

2, 3

	

2, 3

	
********

	
******** 

******** 

	
 

******** 

text text

YOU Deposited

text text

text text
YOU Deposited

text text

text text

YOU Deposited
text text

text text

YOU Deposited
text text

text text

YOU Deposited
text text

text text

YOU SAVED

text text

	
 

******** 

text text

YOU Deposited
text text

text text

YOU Deposited
text text

text text

YOU Deposited
text text

	
******** 

******** 
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11.	 Identify your trigger type: 
a.	 Trigger Type – Tells the printer where the trigger string is located.
1.	 “Trigger is on line above line(s) to surround” – Instructs the printer that the trigger string in located one line above the line to be 

circled.
2. “Trigger is on first line to surround” – Instructs the printer that the trigger string is located on the first line to  

be surrounded.
3. “Trigger is char. attribute for surrounded text” – Instructs the printer not to trigger on text but to trigger on a character attribute 

such as bold, italics, etc.
4. “Trigger types 1 and 2 combined(Aux Trigger)” – Instructs the printer that the trigger 

string is located one line above the line to be circled as well as on the first line to be 
circled. Combines trigger types 1 and 2. When this trigger type is selected, a box will 
appear entitled Aux Trigger String. Within this box, you can enter an auxiliary trigger 
if you wish.

12.	 Choose the Behavior of the line that contains the trigger.
a.	 Behavior – Instructs the printer on what to do to the line that contains the trigger 

string. 

i.	 Graphic replaces trigger line – Surround Graphic replaces the line containing the text 
trigger.

ii.	 Graphic does not replace trigger line – Surround Graphic does not replace the line 
containing the text trigger.

13.	 Choose whether or not you wish to have the surrounded text contained within the Data 
Surround Area printed in color or in black. To do this, simply select the appropriate radio 
button located in the Surround Text Color section. 
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	 Legacy Color Triggers	
Most financial applications do not support two-color thermal printing, while many POS printers are fully capable of doing so. The cost of 
changing the application to support this feature has precluded the majority of financial end users from doing so, and therefore has kept 
them printing in monochrome. The Legacy Color Trigger feature of CognitiveTPG’s ReceiptWare gives you the ability to print an entire 
line in color when it recognizes a user-defined text string sent down from the POS application. This feature is similar to Text Attribute 
Substitution in that black text can be made to print in color. The text is colorized not by attribute (bold, italics) but by its content. For 
example, if your application uses the symbol @ to indicate price per item, you can instruct the printer to print any line that contains the 
@ symbol in color and bold.
					     Before:	 1 @ $3.50
					     After:	 1 @ $3.50
The software supports up to 63 different legacy color triggers. 

Using the Legacy Color Tool
As with every other ReceiptWare tool, we recommend having a sample receipt present with you when creating Receipt Formats. 
When specifying “triggers,” we advocate avoiding the use of numbers as well as text that could appear elsewhere in your receipt. Try to 
choose a trigger that is unique and will be printed only on specific transactions. This will reduce the chance of printing a graphic, be it 
conditional or surround, in an undesired place on the receipt. 
1.	 Open the ReceiptWare software application.
2.	 Click on Other Triggers tab.
3.	 Assign the trigger number by using the toggle Current Trigger buttons (< or >) 

located underneath the Legacy Color Triggers section, which is on the top right-hand 
side of your main screen. Use the default number, which is 192, or advance for  
multiple triggers. 

4.	 Type a trigger string into the field labeled Enter trigger string. This is the string that the 
printer will search for to trigger the color print command. It is case and space sensitive, 
can be 1 to 23 characters long, and can only be from the ASCII character set. Once you 
have finished, move to the next trigger, if you desire another. To scroll up to the next 
trigger, use the Current Trigger > button. To go back to a previously defined trigger, use 
the < button. 

5.	 Repeat step 4 to define all the Legacy Color Triggers that you want to include.

Legacy Color Trigger Guidelines 
•	 Attempting to trigger off a text string already specified as a trigger in other tools will lead to unknown results.
•	 Make sure that you choose trigger strings that will not appear in other parts of the receipt or the printer may print the Legacy Color 

Trigger at an undesired location.
•	 To disable Legacy Color Trigger, remove any trigger string from the Enter Trigger String field. 
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	 Logo Suspension
As mentioned in the Legacy Functionality portion of this user guide, Legacy Graphics (Top Logo, Bottom Logo, Watermarks, and Margin 
Messages) included within your Receipt Format (AXI file), will be printed on every receipt that is generated. However, you may wish to 
print these graphics on every transaction receipt, but not on the Credit Authorization Slips that are sometimes subsequently printed. 
The Logo Suspension feature of ReceiptWare, gives you the ability to suppress graphics on certain types of receipts such as credit 
authorization slips, warranty receipts, or returns. 

Using Logo Suspension Triggers
As with every other ReceiptWare tool, we recommend having a sample receipt present with you when creating Receipt Formats. When 
specifying “triggers,” we advocate avoiding the use of numbers as well as text that could appear elsewhere on your receipt. Try to choose 
a trigger that is unique and will be printed only on specific transactions. This will reduce the chance of suspending a Legacy Graphic or 
other graphics when it was not intended. 
1.	 Open the ReceiptWare software application.
2.	 Click on Other Triggers tab.
3.	 Assign the trigger number by using the toggle buttons (< or >) located underneath 

the Logo Suspension Triggers section, which is on the top left-hand side of your main 
screen. 

4.	 Type a trigger string into the field labeled Enter trigger string. This is the string that 
the printer will search for in order to suppress the Legacy Graphics that you specify. It is 
case and space sensitive, can be 1 to 23 characters long, and can only be from the ASCII 
character set. 

5.	 Identify the Behavior of your trigger string. Choosing its Behavior will determine if the 
trigger string will be printed on the receipt. Options include:
a.	 “Print trigger string” – Instructs the printer to print the trigger string.
b.	 “Do not print trigger string” – Instructs the printer not to print the trigger string.

6.	 After you have chosen how the trigger string will behave, the next step is to choose the Legacy Graphic(s) that you 
wish to pause. To do this, check the boxes next to the appropriate graphic within the section called Items to suspend.  
Options include:
a.	 Top Logo
b.	 Bottom Logos
c.	 Margin Message
d.	 Watermark 

7.	 Choose when the graphics are suspended. By default, the printer will immediately turn off the Legacy Graphic(s) that you specified 
in step 6 when it sees the associated trigger string(s). However, if you wish to keep printing these graphics until the next receipt is 
about to be printed, check the box next to option Do not suspend until after next knife cut. Choosing this option will instruct the 
printer to keep printing all of the Legacy Graphics until the next knife cut or until the current receipt is finished printing. 

8.	 Define how long the printer should suspend the particular Legacy Graphic(s) that you specified in the Legacy Graphics section. This 
parameter is measured in terms of the number of knife cuts. Enter a value in the field next to the option called Enter the number 
of knife cuts to suspend the selected items for. The allowed range for possible values is 1 to 64 knife cuts. This is useful if your 
application prints multiple receipts for things like rebates, credit authorization slips, merchant/customer copies, etc. 

9.	 Once you have finished, move to the next one, if you desire another. To scroll up to the next trigger use the > button. To go back to 
a previously defined trigger use the < button. 
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Logo Suspension Trigger Guidelines
•	 Attempting to trigger off a text string already specified as a trigger in the other tools 

will lead to unknown results.
•	 Make sure that you choose trigger strings that will not appear in 

other parts of the receipt or the printer will print the Legacy Graphic at an  
undesired location.

•	 To disable Logo Suspension Triggers, remove any trigger string from the user entry 
field. 
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	 User Additions
The User Additions feature of ReceiptWare gives you access to printer functions that are not currently automated by ReceiptWare. It is 
an advanced tool that allows you to manually change the behavior of the printer. Unless you are very familiar with HEX command sets 
and printer firmware, we do not suggest that you use this feature. 

Using the User Additions Tool
As with every other ReceiptWare tool, we recommend having a sample receipt present with 
you when creating Receipt Formats. When specifying “triggers,” we advocate avoiding the use 
of numbers as well as text that could appear elsewhere in your receipt. Try to choose a trigger 
that is unique and will be printed only on specific transactions. 
1.	 Open the ReceiptWare software application.
2.	 Click on User Additions tab.
3.	 Enter command sets into the field called User Additions to the Receipt Format File.

	 Print Sample
After you have created your Receipt Format file, you will want to see how all of your graphics and triggers will look on a printed receipt. 
ReceiptWare’s Print Sample feature gives you the ability to do so. This function allows you to “print preview” the Legacy Graphics, Text 
Attribute Substitutions, Financial Conditional Graphics, Conditional Surround Graphics, Legacy Color Triggers, Logo Suppression Triggers, and 
User Additions that you specified. With a sample of the graphics, triggers, and instructions in your hand, you can go back into the AXI file and 
make adjustments before saving the final copy and deploying it. 

Using the Print Sample Tool
1.	 Open the ReceiptWare software application.
2.	 Click on the Print Sample tab.
3.	 Click on the Save AXI button if you have not already saved it.
4.	 Assuming that you have a POS printer attached to your PC and a copy of the POS 

Download Utility installed, click on the Download to local Printer button. The POS 
Download Utility will execute. You can follow the progress by reading the messages 
in the status window. When the download is complete, the POS Download Utility 
will close. If there was no error downloading the file to the printer, you will receive 
no further messages. If there was an error, you will see a message box that indicates 
the location of the status file that provides further information on the error. 

Note:	 Depending upon the file size that is being downloaded to the printer, a one-minute 
delay can be expected after the POS Download Utility launches. Download progress 
can be monitored within the utility’s Status window. 

5.	 Click on the Print Sample Receipt button located at the bottom of the screen. A 
sample receipt will print.

	To print a sample, a CognitiveTPG printer must first be connected to and 
communicating with the PC on which you are operating. Please make sure that your printer’s communication settings 
are configured to operate with ReceiptWare’s POS Download Utility. We also recommend optimizing your printers logo 
storage space by reallocating the printers memory. Please consult the relative printer User Guide to learn how to change 
a printer’s communication and memory configurations.
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	 Make Download Package
CognitiveTPG’s ReceiptWare gives you the ability to create Receipt Format files (AXI) that contain triggers, graphics (LGO files), and 
instruction sets, which can be saved, edited, and downloaded to numerous printers and computers. To share an AXI or Receipt Format 
file with other computers or printers, creating a Download Package is necessary. A Download Package contains all of the files that are 
necessary to be sent to the printer to produce the desired Receipt Format. The heart of this package is the Receipt Format file (AXI). This 
file contains data and instruction sets needed to execute the Receipt Format that you specified. The rest of the package contains all of 
the logo files that you specified to be included on your receipts. A download package is path-independent, which means that regardless 
of where the logos are located on your PC, you can safely move the entire Download Package to any directory on any other computer 
and download it to the printer.
Note:	 The Receipt Format file (AXI) that is copied to the output directory when making a Download Package has a different format than 

“native” (AXI) Receipt Format files. It is meant to be processed by the POS Download Utility on another computer and therefore 
should never be opened with ReceiptWare. 

Using the Make Download Package Tool
1.	 Open the ReceiptWare software application.
2.	 Click on the Make Download Package tab.
3.	 If you already have a Receipt Format file (AXI), then select Open from the ReceiptWare menu and open the file. Make any desired 

changes, and then save the file. You can do this by either selecting File>Save or by clicking on the Save AXI File button located at 
the top of your screen. If you do not have a receipt file, you can create a new one by selecting File>New from the file menu.

4.	 Select a directory where the download package will be saved. To do this, click 
on the Select Download Directory button in the middle of your screen. This will 
prompt the window Select A Directory for Logos and AXI File to appear. You can 
either type in the full pathname to the directory file in the field entitled Download 
Folder or specify it through Windows® Explorer. Once you have the download folder 
specified, click on the Save button at the bottom of the Select A Directory for Logos  
and AXI File window. 

5.	 Click on the button Generate Output Files. If there were no errors creating a download 
package, you will receive the following message: “You can now move all the files located 
in: YOUR SPECIFIED DIRECTORY/THE NAME OF YOUR AXI FILE to another PC.” 

	When moving a download package, make sure that the AXI and LGO files 
remain in the same folder. Moving, deleting or altering file names will effect 
the AXI files that reference LGO graphics.
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	 Other Tools
While ReceiptWare makes it simple for you to turn your receipts into customer retention tools that you control, its additional tool set 
makes it even easier. 

Using the Other Tools
1.	 To access these tools, click on the Tools drop-down menu located on the main menu bar of the main  

ReceiptWare window.

Tools include:
a.	 Bitmap Conversion Tool – Tool that converts all of the graphics that you wish to use 

fromBMP files to LGO files.
b.	 ReceiptWare Download Utility – Utility used to download a specified AXI file to the 

attached printer(s).
c.	 Diagnostics – Tool that instructs the attached printer to print out detailed instructions 

on what is currently loaded on the printer (AXI file), as well as a current hardware 
diagnostics. Options include: 

i)	 Trigger Data – Details the current trigger strings that are resident on the printer. 
Information includes:

•	 Main – Actual trigger string loaded
•	 Logo Mode – Type of trigger loaded

–	 Conditional graphic

–	 Conditional surround graphic

–	 Legacy colorization

–	 Logo suspension

•	 Logo ID – Assigned logo number
•	 Justification – Left, right, or center
•	 Replace – Details whether specified graphic will replace the associated trigger string

–	 ON

–	 OFF

•	 Red Text – Details whether the trigger string turns on the print color command
–	 ON

–	 OFF

•	 Triggers Active – Informs the number of active triggers
•	 Slots Open – Details the number triggers still available
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Legacy Settings  
Legacy settings inform the user of the settings of the active legacy settings (Legacy Graphics and Text Attribute Switching). Information 
includes:
1.	 Precut Logo – Indicates whether a Top Logo is specified.

i)	 Active 

ii)	 Disabled

a.	 Dot rows before logo – Margin specified above the Top Logo
b.	 Dot rows after logo – Margin specified below the Top Logo

2.	 Post Cut Logo – Indicates whether a Bottom Logo is specified.
i)	 Active 

ii)	 Disabled

a.	 Dot rows before logo – Margin specified above the Bottom Logo
b.	 Dot rows after logo – Margin specified below the Bottom Logo

3.	 Side Graphics – Indicates the print settings for Margin Messages.
i)	 Alternating 

ii)	 Both sides

iii)	Right margin only

iv)	Left margin only 

a.	 Start Delay – Indicates when the Margin Messages will start to print in dot rows relative to the start of the  
print data

b.	 Repeat spacing – Indicates the spacing in dot rows between Margin Messages
4. 	 Watermark Graphics – Indicates whether a Watermark is specified.

a.	 Repeat spacing – Indicates the spacing in dot rows between Watermark graphics
5.	 Attribute Substitution #1 – Indicates whether the first set of text attributes is set to be switched.

i)	 Active

ii)	 Disabled

a.	 Application Attribute Combination – Indicates the text attribute that is set to be switched
b.	 Replaced with – Indicates the text attribute that will replace the “Application Attribute Combination” 

6.	 Attribute Substitution #2 – Indicates whether the second set of text attributes is set to be switched.
i)	 Active

ii)	 Disabled

a.	 Application Attribute Combination – Indicates the text attribute that is set to be switched
b.	 Replaced with – Indicates the text attribute that will replace the “Application Attribute Combination” 

i)	 Available Logo Information – 

ii)	 Configuration Page – 

c.	 Comm Settings – Allows you to specify or change the communication parameters
d.	 Paper Type Settings – Permits you to specify the paper type on which you will be printing. Options include: Type 0. – P310 

Monochrome, Type 1. – P310RB, Type 4. – P320BB, Type 5. – P320RB, M770B, No Change



26

	 Frequently Asked Questions
What does ReceiptWare do?
ReceiptWare is an “application independent” software tool for Windows® that allows POS printers to print customized Receipt Formats, 
graphics, and promotions based on individual customer transactions.
What can I do to my receipt using ReceiptWare software?
CognitiveTPG’s ReceiptWare changes the way you use and think about your receipts. Top Logos, Margin Messages, Watermarks, 
and Bottom Logos can all be added to enhance corporate image, while features such as Surround Graphics, Text Attribute 
Substitution, and Conditional Graphics allow you to present customized receipts targeted at specific customers. Individualizing 
each receipt is simple with ReceiptWare’s numerous triggers that allow you to call attention to special savings, rewards, 
and promotions in either monochrome or color. Using your imagination, you can create the look of receipts you have  
always wanted.
What is an AXI file?
An AXI or Receipt Format file contain the triggers, graphics (LGO files), and instruction sets that you can specify in the ReceiptWare 
software. They can be saved, edited, and downloaded to numerous printers and computers.
What printers currently have ReceiptWare functionality?
At the present time, ReceiptWare works only on CognitiveTPG’s A760, A776, B780 and A799 printers with ColorPOS technology.
What operating systems does ReceiptWare currently work with?
ReceiptWare currently operates on Windows®  XP, Vista and Win7.
How do I obtain a copy of ReceiptWare?
To download a free copy of ReceiptWare, go to www.CogntiveTPG.com.
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How do I receive technical support?

Before contacting the Technical Support Center, you must have the following information readily available:
•	 Your name and the product’s serial number. 
•	 Information about your computer: processor type, speed, amount of RAM installed, and available hard-disk space. 
•	 Product name and version level. To see this, click Help>About, which will display the product and version information. 
•	 Other applications that you are using in conjunction with ReceiptWare. 
•	 Any specific error messages or codes that were displayed. 
•	 A description of what you were doing when the error occurred. Try to recreate the error before contacting the technical support 

center. 
•	 Once you have received this information, contact the Help Desk at:
	 ReceiptWare Tech Support 

T:	 877 209 0156 
E:	 tsupport@Cognitivetpg.com

What are the ReceiptWare technical support hours?
Currently, live CognitiveTPG ReceiptWare technical support hours are 8:00 a.m. to 5:00 p.m. EST Monday through Friday.
Is training available for ReceiptWare?
ReceiptWare’s concise and easy to understand manual should be all that you need to start creating dynamic receipts and 
promotions. However, if you need something clarified or explained in greater detail, please feel free to contact us  
at any time at the number listed above.
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	 Customer Service and Technical Support
You can contact technical support for ReceiptWare by telephone, or email. 

Information Required Before You Contact Technical Support
Before contacting the Technical Support Center, you must have the following information readily available:
•	 Your name and product ID (located on the label affixed to the product packaging).
•	 Information about your computer: processor type, speed, amount of RAM installed, and available hard-disk space. 
•	 Product name and version level. To see this, click Help>About, which will display the product and version information. 
•	 Other applications that you are using in conjunction with ReceiptWare.
•	 Any specific error messages or codes that were displayed.
•	 A description of what you were doing when the error occurred. Try to recreate the error before contacting the technical support 

center. 
If you do not have this information available, you may experience a delay in obtaining technical support. 

Email Support
If you need help on a non-emergency basis, please take advantage of this service. For questions about or support for ReceiptWare, send 
your email to:
	 tsupport@CognitiveTPG.com 
Be sure to include in your email all of the information shown in “Information required before you contact Technical Support” (above). 
Emails without this information might not receive a complete response. 

Telephone Support
If you need help immediately and email support is insufficient, please contact us at our toll free number:
		  800-732-8950, option 4
As previously mentioned, please be sure to have all of the information shown in “Information required before you contact Technical 
Support.”

Online Support
Online support can be reached at http://www.CognitiveTPG.com. 



29

AXI
Proprietary file type created by ReceiptWare that contains graphics, 
instructions, and settings, which can be downloaded to a ReceiptWare 
capable printer.
Baud Rate
A variable unit of data transmission speed (as one bit per second). 
Set or change the POS printers baud rate to change the printing 
speed.
Bitmap
An array of binary data representing a bitmapped image or 
display. The use of pixels (any of the small discrete elements 
that together constitute an image, as on a television screen) to 
produce an image.
BMP
Bitmap file format. 
Bottom Logo
A bottom logo is a user-defined graphic that prints at the end of 
the receipt. 
Financial Conditional Graphics
ReceiptWare allows you to trigger the printing of a Financial 
Conditional Graphic in place of or including a predefined trigger 
string.
Legacy Graphics
The ability to print Top Logos, Watermarks, Margin Messages, and 
Bottom Logos without changing your POS application.
LGO
ReceiptWare’s Bitmap Conversion Tool converts BMP files to LGO 
files. ReceiptWare will only support LGO files.

Margin Message
Margin Messages are user-defined graphics that print 
along the margins of a printed receipt at locations that  
you specify. 
Receipt Format	
All of the compiled elements of a receipt that make an AXI file 
format, which the POS printer recognizes and prints.
Map or Re-Map
Convert multiple colors in an existing BMP file to two colors in order 
to send to the printer. Use the “Bitmap Conversion Tool” to do this.
Surround Graphics
The ability to substitute current methods of highlighting with 
“surround” graphic shapes and a color.
Text Attribute Switching
Lets you select current attributes and substitute them with other 
attributes – most likely including color.
Top Logo 
A Top Logo is a user-defined graphic that prints at the top of the 
receipt before any other data is printed.
Trigger 
A trigger consists of predefined text string(s) that cause  
user-defined highlights or graphics to print.  
Watermark
Watermarks are user-defined graphics that print behind the receipt 
data in the receipt to help reduce the occurrence of receipt fraud.  

	 Glossary of Terms


